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Introduction

This document is intended for use with the IBM
®

Cognos
®

Disclosure Management
samples. It includes information on planning, preparing for, and installing samples,
and finding and configuring the samples after installation.

The IBM
®

Cognos
®

Disclosure Management samples illustrate product features and
business best practices. You can experiment with them, use their report design
techniques, and use them to troubleshoot.

Where to find the samples

The samples are included with Cognos Disclosure Management on a separate disk.
Contact your administrator to find out where the sample files are installed.

Finding information

To find IBM® Cognos® product documentation on the web, including all translated
documentation, access one of the IBM Cognos Information Centers
(http://pic.dhe.ibm.com/infocenter/cdm/v10r2m1/index.jsp). Release notes are
published directly to Information Centers, and include links to the latest technotes
and APARs.

You can also read PDF versions of the product release notes and installation guides
directly from IBM Cognos product disks.

To view Cognos Disclosure Management help in the product, click File > Help >
Help.

Accessibility features

In this release, there are no added accessibility features for samples. The material
will be available in English only. However, the TM1 data source sample_outdoors
does have language aliases for 21 languages. Accessibility features help users who
have a physical disability, such as restricted mobility or limited vision, to use
information technology products.

IBM Cognos HTML documentation has accessibility features. PDF documents are
supplemental and, as such, include no added accessibility features.

Forward-looking statements

This documentation describes the current functionality of the product. References
to items that are not currently available may be included. No implication of any
future availability should be inferred. Any such references are not a commitment,
promise, or legal obligation to deliver any material, code, or functionality. The
development, release, and timing of features or functionality remain at the sole
discretion of IBM.

Samples disclaimer

The Sample Outdoors Company, Great Outdoors Company, GO Sales, any
variation of the Sample Outdoors or Great Outdoors names, and Planning Sample
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depict fictitious business operations with sample data used to develop sample
applications for IBM and IBM customers. These fictitious records include sample
data for sales transactions, product distribution, finance, and human resources.
Any resemblance to actual names, addresses, contact numbers, or transaction
values is coincidental. Other sample files may contain fictional data manually or
machine generated, factual data compiled from academic or public sources, or data
used with permission of the copyright holder, for use as sample data to develop
sample applications. Product names referenced may be the trademarks of their
respective owners. Unauthorized duplication is prohibited.
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Chapter 1. The IBM Cognos Disclosure Management Samples

The IBM
®

Cognos
®

Disclosure Management samples illustrate product features and
technical and business best practices. You can experiment with them, use their
report design techniques, and use them to troubleshoot. If you want to use the
samples, install them from the Cognos Disclosure Management Samples disk or
from the location where you downloaded and extracted the files.

All of the financial data required for the Cognos Disclosure Management sample
reports is available in the Financefact4 cube within the sample_outdoors IBM
Cognos TM1® application. If TM1 is not available, then the financial data can be
found on the sample_outdoors.xls worksheet.

The samples consist of the following:
v Microsoft SQL Server 2008 R2 databases that contain the Cognos Disclosure

Management, IBM
®

Cognos
®

Disclosure Management XBRL and cache restore
files

v Sample TM1 cubes and the related application model
v Reports
v Sample taxonomy

Files on the Cognos Disclosure Management Samples disk

The sample set CDM samples.zip includes the following folders:

Important: Your login credentials are user name: Administrator and the password
is !Admin321

soc 2012-12-31 sample taxonomy
Sample taxonomy files including .xsd entry point file.

sample_outdoors TM1 application
Users who have access to IBM Cognos TM1 may connect to this sample
application as an OLAP data source.

Core Database
The core database consists of three separate database files:
v Samples_CDM

v Samples_CDMCache

v Samples_CDMXbrl

10-K source files
The sample_outdoors.xls file contains various source data that can be used
to create Open Database Connectivity (ODBC) data sources.

10-K report security
Sample Outdoors Company (SOC) users list the various users of the
sample system. The security.xls file outlines the user ID and their user
group associations. The default password is Passw0rd.

10-K report objects
The report objects list the various Microsoft Excel and Word files
incorporated into the Sample Outdoors Company sample 10-K report and
can be used and modified as required to create other sample reports.
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10-K report export file
The entire Sample Outdoors Company sample 10-K report is available for
import.

10-K instance files
Instance files have been generated based on the tagged Income Statement
and Balance Sheet.

10-K generated reports
The entire Sample Outdoors Company sample 10-K report has been
generated so that the finished report can be viewed in its entirety.

Two reports within the Sample 10-K report have been tagged using the Sample
Outdoors Taxonomy. These include the following:
v The Income Statement (Role 15100 - Statement of Operations - Statement of

Income, Including Gross Margin [Table])
v The Balance Sheet (Role 10100 - Statement of Financial Position- Statement of

Financial Condition, Classified [Table])
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Chapter 2. Importing the IBM Cognos Disclosure Management
Sample report

The IBM
®

Cognos
®

Disclosure Management samples illustrate product features and
technical and business best practices. You can experiment with them, use their
report design techniques, and use them to troubleshoot.

Before you begin

Before you can use the sample report, Cognos Disclosure Management must be
installed, configured, and running. Save the samples on your local computer from
the Cognos Disclosure Management Samples disk or from the location where you
downloaded and extracted the files.

Before you import the sample report, prepare the following information:
v You must know the master encryption password. The password is Passw0rd.
v You must know which report group will contain the imported report.
v You might need to specify how to associate user taxonomies with projects.

– If there is one user taxonomy with the required entry point URI, the import
process automatically associates the taxonomy with the appropriate project.

– If there is more than one user taxonomy with the required entry point URI,
you must specify which project to use.

– If there is no user taxonomy with the required entry point URI, you must
manually import the taxonomy first. For more information, see the topics on
adding taxonomies in the IBM Cognos Disclosure Management XBRL
Administration Guide.

v You must be prepared to resolve conflicts with XBRL aspects. Some aspects
might have names that conflict with existing aspects. For each conflicting aspect
name, you must select one of the following options:
– Replace the aspect being imported with the existing aspect. Any items that

reference the aspect that is being imported will now reference the existing
aspect.

– Rename the aspect that you are importing.

Procedure
1. Click the Home tab and, in the Navigation pane, click Administration.
2. Double-click Reports.
3. Click Import.
4. Navigate to the location where you saved the Sample Outdoors Company 10K

report.cdm file. This is the 10-K report export file that is included on the
Samples disk.

5. Complete the remaining steps in the Import Reports wizard.

Results

When the import process is complete, a summary provides the following
information:
v Number of reports imported
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v Number of report objects imported
v Number of projects imported
v Number of taxonomies imported
v A list of the imported data sources that you might need to fix later

What to do next

After you have imported the report, you must ensure that your users are assigned
relevant permissions to view the report. You will also need to assign workflow to
the objects so that the users with access to the report are able to edit the objects
given their workflow access rights.

Importing the sample taxonomy
You can import the sample taxonomy into IBM

®

Cognos
®

Disclosure Management.

About this task

After a taxonomy is imported, you create or associate a project that includes the
taxonomy and a report. You can then use the project to tag the report using the
associated taxonomy.

Procedure
1. Click the Home tab and, in the Navigation pane, click Administration.
2. Under XBRL, double-click Taxonomies.
3. Click Add > Taxonomy From File.
4. In the Add a taxonomy window, specify a name for the taxonomy.
5. Optional: Specify a description for the taxonomy.
6. Click Add.
7. Browse to the location of the taxonomy files, and select all of the files that are

related to the soc 2-12-12-31 sample taxonomy. Then click Open. Cognos
Disclosure Management XBRL selects an XSD file as the entry point for the
taxonomy, indicated by a check mark in the Flags column.

8. If needed, select the entry point file in the list and click Set Entry Point.

Important: At least one file must be an XBRL entry point file.
9. Optional: If you want to validate the taxonomy files against EDGAR Filer

Manual rules, select the EFM (EDGAR Filer Manual) check box. The
taxonomy is automatically validated against the XBRL 2.1 and Dimensions
specifications.

10. Optional: If you want to edit this taxonomy, select the Make Editable check
box. Taxonomy editing is described fully in IBM Cognos Disclosure
Management Extension Taxonomy Editor User Guide.

11. Click OK.

What to do next

When you import the sample taxonomy into IBM
®

Cognos
®

Disclosure
Management Extension Taxonomy Editor you must validate it. Two known errors
and two known warnings will occur. To resolve them, perform the following steps:
v Right-click the duplicate member error and click Remove all duplicate

document inclusions.
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v Right-click the Calculation Abstract error and click Delete all unused instances
of element.

v For the [IncomeStatement] warning, tag role 15100 as the Income Statement
v For the [BalanceSheet] warning, tag role 10100 as the Balance Sheet
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Appendix. The Sample Outdoors Company

The Sample Outdoors Company samples illustrate product features and technical
and business best practices.

You can also use them for experimenting with and sharing report design
techniques and for troubleshooting. As you use the samples, you can connect to
features in the product.

For examples related to different kinds of businesses, see the product blueprints on
the IBM Cognos Information Centers (http://pic.dhe.ibm.com/infocenter/cogic/
v1r0m0/index.jsp).

The Sample Outdoors Company, or GO Sales, or any variation of the Sample
Outdoors name, is the name of a fictitious business operation whose sample data is
used to develop sample applications for IBM and IBM customers. Its fictitious
records include sample data for sales transactions, product distribution, finance,
and human resources. Any resemblance to actual names, addresses, contact
numbers, or transaction values, is coincidental. Unauthorized duplication is
prohibited.

The Sample Outdoors Group of Companies
It is important to learn about the Sample Outdoors Group of Companies to quickly
design your examples.

Revenue for The Sample Outdoors Company comes from corporate stores and
from franchise operations. The revenues are consolidated from the wholly-owned
subsidiaries. There are six distinct organizations, each with its own departments
and sales branches. Five of these are regionally-based companies.

The sixth company, GO Accessories:
v Has its own collection of products, differentiated from the other GO companies

by brand, name, price, color and size.
v Sells from a single branch to all regions and retailers.
v Functions both as an operating company based in Geneva, and as a part owner

of the three GO subsidiaries in Europe.

The diagram illustrates the consolidated corporate structure, including the
percentage changes in ownership for GO Central Europe, and shows the reporting
currency and GL prefix for each subsidiary.
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Most of the accounts, such as those under non-personnel expenses, are at the
department level, and contain only summary amounts. For example, although each
marketing department has expenses, the cost is unspecified at the transaction level
where marketing promotions occur.

Sample Outdoors organization and schemas
Under the holding company GO Consolidated, there are six distinct sales
organizations, each with their own departments and sales branches. The diagram
below illustrates the consolidated corporate structure.

The Outdoors Companies

Five of the six companies are regionally-based companies, whose sales region is
identified in the company name. These five companies sell the complete line of
outdoor products including:

Figure 1. Consolidated corporate structure

Figure 2. GO Organization
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v Camping Equipment
v Golf Equipment
v Mountaineering Equipment
v Personal Accessories
v Outdoor Protection

The Accessory Company

Go Accessories Inc. operates differently than the five outdoor companies and
stands apart in several other areas:
v GO Accessories has its own collection of accessories, differentiated from the

outdoor companies by brand, name, price, color and size.
v GO Accessories sells from a single branch to all regions and retailers.
v GO Accessories functions both as an operating company based in Geneva, and

as owner or part owner of three GO subsidiaries in Europe. This offers a
complex structure that is useful in samples that show office-of-finance type
reporting.

Unbalanced hierarchy

The ownership by GO Accessories of the European companies supports
applications designed for office-of-finance reporting. Samples applications can
include inter-company eliminations and consolidation up to the top node - GO
Consolidated. In this structure, aggregations of the European organizations occur
through GO Accessories.

GO Departments

The Sample Outdoors companies are divided into operating and corporate
departments. Each organization has the same structure.

Applications for financial and planning data use the department structure in the
sample budgets and forecasts.

Sales branches under operations, and HR departments under corporate, are the
richest sources of data for querying and analysis.

Table 1. Sample Outdoors Departments

Division (GL) Department (GL)

Corporate Sales (Corporate)

Corporate Marketing (1750)

Corporate IS&T

Corporate Human Resources

Corporate Finance

Corporate Procurement

Operations Sales branches

Operations Production and Distribution

Operations Customer Service
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Notices

This information was developed for products and services offered worldwide.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service. This document may
describe products, services, or features that are not included in the Program or
license entitlement that you have purchased.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Software Group
Attention: Licensing
3755 Riverside Dr
Ottawa, ON K1V 1B7
Canada

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.
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Trademarks

IBM, the IBM logo and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “ Copyright and
trademark information ” at www.ibm.com/legal/copytrade.shtml.

The following terms are trademarks or registered trademarks of other companies:
v Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered

trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

v Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

Microsoft product screen shot(s) used with permission from Microsoft.
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